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Preface
Revised: September 13, 2013

Overview
This Cisco Video Surveillance Manager Safety and Security Desktop User Guide provides an overview
of the desktop software used to view video from the Cisco Video Surveillance Manager (Cisco VSM).

Related Documentation
See the Cisco Video Surveillance 7 Documentation Roadmap for descriptions and links to Cisco Video
Surveillance documentation, server and storage platform documentation, and other related
documentation.

Obtaining Documentation, Obtaining Support, and Security
Guidelines
For information about obtaining documentation, submitting a service request, and gathering additional
information, see the monthly What’s New in Cisco Product Documentation. This document also lists all
new and revised Cisco technical documentation. It is available at:
http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html
Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free
service and Cisco currently supports RSS version 2.0.
See also the Related Documentation section.
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1

Getting Started
Contents
• Overview, page 1-1
•

Understanding the Video Viewing Options, page 1-4

•

Requirements, page 1-5

•

Installing the Application, page 1-6

•

Logging In, page 1-7

Overview
The Cisco Video Surveillance Safety and Security Desktop application (Cisco SASD) allows you to
monitor live and recorded video surveillance using a variety of tools. For example:
•

View a list of available cameras based on the camera location.

•

View the cameras and related video on a map.

•

View system alerts and the camera that generated the alert.

•

View multiple cameras in a grid.

•

Create multiple viewing windows and drag them onto additional monitors connected to the PC
workstation.

•

Create Video Walls to display the same pre-defined set of viewing panes on multiple workstations.

•

Use Unattended Mode to automatically open the Video Walls on workstations that do not have a
mouse or keyboard.
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Figure 1-1 describes the main Cisco SASD features.
Figure 1-1

1

Overview of the Cisco SASD Features

Workspaces allow you to view video in a variety of formats:
•

Camera Centric Workspace
—Use the location tree to select a camera. Select a View to view multiple
cameras in a a grid. See the “Viewing Video from Specific Cameras” section on page 2-2.

•

Alert Centric Workspace
—View and modify system alerts. View the camera that generated the alert on a
map, and video from that camera. See the “Viewing Alerts” section on page 6-1.

•

Map Centric Workspace
—Display maps of the Cisco VSM locations, including the camera and alerts at those
locations. Click a camera name to view video. See the “Viewing Cameras and Alerts on Map” section on page 7-1.

•

Video Centric Workspace
—Display video from multiple cameras in a simple grid that maximizes the viewing
area. Drag the See the grid to a separate monitor, if necessary. See the “Viewing Camera Video in a Multi-Pane Grid”
section on page 2-4.

•

Duplicate —Create an additional window of the workspace you are viewing. For example, select the Video
Centric Workspace tab
and click the duplicate icon
to create a new window and drag it to a separate monitor.
See the “Viewing Camera Video in a Multi-Pane Grid” section on page 2-4 and the “Displaying a Video Grid on a
Separate Monitor” section on page 2-5.
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2

Select a menu to configure maps and locations, select a multi-pane View, create a Video Wall, or create an unattended
workstation.
•

File
– Settings > Server—Displays the server IP address or hostname of the Operations Manager that you are

connected to.
– Unattended SASD Configuration—Configure a workstation to automatically open and operate Video Walls

without user interaction. The workstation can be placed out of reach (such as below a desk) without a mouse or
keyboard. See the “Configuring Unattended Windows” section on page 3-1.
– Map Editor—Edit the location hierarchy and add map images to the locations. See the “Editing Locations and

Maps” section on page 8-1.
– Exit—Close the Cisco SASD application and disconnect from the Operations Manager. Unattended screens will

still be displayed on the workstation, if configured.
•

Views
– Blank—Create a blank matrix from the available layouts and drag cameras onto each viewing pane.
– Views—Select a pre-defined matrix of cameras. The cameras can be configured to automatically rotate.

See the “Viewing Camera Video in a Multi-Pane Grid” section on page 2-4.
•

Wall—Select a pre-defined matrix of viewing panes that can be displayed on multiple workstations (called Video
Walls). You can also use Video Walls to create unattended workstations.
– Creating a Video Wall, page 2-8.
– “Configuring Unattended Windows” section on page 3-1.

•

Help—View additional information and documentation.

3

Sidebar—Sidebars vary for each workspace. Click the triangle

4

Playback Controls—See the “Controlling Video Playback” section on page 4-1.

5

Viewing Pane—See the “Controlling Video Playback” section on page 4-1.

6

Publish to Wall—Display a View on all instances of a Video Wall, including Video Walls on other workstations. See the
“Creating a Video Wall” section on page 2-8.

7

Create Clone—Create an exact duplicate of the Camera Centric workspace including the selected View and cameras.

8

Performance Meter—Displays the workstation’s CPU performance based on available memory and bandwidth.

to display or hide the sidebar.

•

Green indicates that the workstation is meeting the demands of the Cisco SASD activities.

•

Yellow is a performance warning.

•

Red indicates that the workstation performance is poor and processing delays may occur.
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Understanding the Video Viewing Options
Cisco SASD offers the following video viewing methods.
Table 1-1

Video Viewing Options

Viewing Mode

Description

Single Camera

View video from a single camera based on a
location, alert or map.

Multiple Cameras

Tip

Select a View to view a multi-pane matrix of
live or recorded video. The Views menu is
available in the Camera Centric and Video
Centric Workspaces (Figure 1-1).

More Information
•

Viewing Video from
Specific Cameras, page 2-2

•

“Viewing Alerts” section on
page 6-1

•

“Viewing Cameras and
Alerts on Map” section on
page 7-1

•

Viewing Camera Video in a
Multi-Pane Grid, page 2-4

•

Displaying a Video Grid on
a Separate Monitor,
page 2-5

Video Walls

View the same video pane matrix on
multiple workstations.

Creating a Video Wall, page 2-8

Unattended Mode

Display a Video Wall on a workstation that
does not include a keyboard or mouse. The
Video Walls can appear automatically even
if the workstation is rebooted.

Configuring Unattended
Windows, page 3-1

See the “Controlling Video Playback” section on page 4-1 for instructions to control playback of live or
recorded video.
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Requirements
Cisco Video Surveillance Safety and Security Desktop (Cisco SASD) requires the following.
Table 1-2

Requirements

Requirement
Complete?
( )

Requirements
At least one Cisco VSM server must be installed on the network with the following applications enabled:
•

Cisco Media Server application.

•

Cisco VSM Operations Manager application



See the following documentation for more information to install and configure the server:
•

Cisco Physical Security Multiservices Platform Series User Guide for instructions to physically install
the server.

•

Cisco Video Surveillance Management Console Administration Guide for instructions to enable the
Media Server and Operations Manager applications.

•

Cisco Video Surveillance Operations Manager User Guide for instructions to configure network and
analog cameras to stream live and recorded video.

At least one camera physically installed and configured on Cisco VSM Operations Manager.
The IP address or hostname of the Cisco VSM Operations Manager.
A valid Cisco Video Surveillance username and password.
See the Cisco Video Surveillance Operations Manager User Guide for instructions to configure users and
access permissions.
Workstation Requirements:
See the Cisco Video Surveillance Monitoring Workstation Performance Baseline Specification for detailed
requirements. The basic requirements are:
•

A PC or laptop running Windows 7 64-bit operating system.

•

The Microsoft .NET Framework 4.0 (full setup) must be installed on the client PC. Go to
http://www.microsoft.com/en-us/download/confirmation.aspx?id=17851 to download the installer.

•

A standard Windows 7 user account.

Note



Logging in with a Guest account can prevent video streaming and result in an error to be displayed in
the video pane: “Cannot create RTSP connection to server. Check network connection and server
health status.”

Cisco Multi-Pane Video Surveillance client software, an Active X client that enables video playback and other
features.
Note







You will be prompted to install this utility when installing or updating the Cisco SASD application.
Complete the on-screen instructions, if prompted. You must have administrative privileges on the PC
workstation to install the software.
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Installing the Application
Procedure
Step 1

Verify that the system and workstation requirements are met, as described in the “Requirements” section
on page 1-5.

Step 2

Install the Microsoft .NET Framework 4.0, if necessary.
Go to http://www.microsoft.com/en-us/download/confirmation.aspx?id=17851 to download the
installer.

Step 3

Log in to the Cisco VSM browser-based Operations Manager.
a.

Launch the 32-bit or 64-bit version of Internet Explorer 8 on your Windows 7 computer.

b.

Enter the URL for the Cisco VSM Operations Manager.

c.

Enter your username and password.

d.

Choose the default “localhost” if your account was created using the Operations Manager. Select a
Domain if you are a user from an external database (Active Directory LDAP domain).

e.

Enter a new password if prompted.

f.

You must enter a new username the first time you log in, or when your password periodically
expires.

Step 4

Select the Operations tab.

Step 5

Click Safety and Security Desktop (under the Software heading).

Step 6

Follow the onscreen instructions to complete the installation.

Tip

•

To access the application on your workstation, double-click the Safety And Security Desktop icon
on your desktop, or go to Start > All Programs > Cisco > Cisco Safety And Security Desktop.

•

You can save the installer file and use it to install the application on multiple workstations, if
necessary. Users must have a valid Cisco VSM username and password to access the system.

•

An error appears if the Microsoft .NET Framework 4.0 is not installed. Go to
http://www.microsoft.com/en-us/download/confirmation.aspx?id=17851 to download the installer,
then repeat this procedure.

•

If prompted, complete the on-screen instructions to install or upgrade the Cisco Multi-Pane Video
Surveillance client software on your computer. This application is an Active X client that enables
video playback and other features. Video will not play unless the Cisco Multi-Pane client software
is correctly installed. You must have administrative privileges on the PC workstation to install the
software.
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Logging In
Procedure
Step 1

Double-click the Safety And Security Desktop shortcut
Programs > Cisco Safety And Security Desktop.

Step 2

Enter the following login information:

Note

on your desktop, or select Start Menu >

•

Server—The IP address or hostname of the Cisco VSM Operations Manager.

•

Domain—Select “localhost” if your account was created using Cisco VSM, or select another option
if logging in from an external database (Active Directory LDAP domain).

•

Username—Enter the username provided by your system administrator.

•

Password—Enter the password provided by your system administrator.

•

You will be prompted to change your password the first time you log on, or when your password
expires. The first-time login password can only be changed by the Operations Manager
administrator.

•

You must log in with a standard Windows 7 user account. Logging in with a Guest account can
prevent video streaming and result in an error to be displayed in the video pane: “Cannot create
RTSP connection to server. Check network connection and server health status.”

Changing Your Password
To change your password, log on to the browser-based Cisco VSM Operations Manager and click on
your username.
Step 1

Launch the Internet Explorer (IE) 8 web browser.

Step 2

Enter the same IP address/hostname used to access the Cisco SASD.

Step 3

Enter the same username and password used to access the Cisco SASD.

Step 4

Click on your username in the upper right corner of the Cisco VSM Operations Manager.

Step 5

Enter and reenter your new password.

Cisco Video Surveillance Manager Safety and Security Desktop User Guide
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Viewing a Video Grid
To view video from multiple cameras in a grid layout, refer to the following topics.
Contents
•

Viewing Video from Specific Cameras, page 2-2

•

Viewing Camera Video in a Multi-Pane Grid, page 2-4

•

Displaying a Video Grid on a Separate Monitor, page 2-5

•

Creating a Video Wall, page 2-8
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Viewing Video from Specific Cameras
To view video from one or more selected cameras, click the Camera Centric Workspace
(Figure 2-1).
Figure 2-1

tab

Camera Centric Workspace

1

Camera Centric Workspace tab (

2

Wall—Select a Video Wall that can appear on multiple workstations.

)

See the “Creating a Video Wall” section on page 2-8.
3

View menu. Select one of the following:
•

Blank—displays a blank matrix of video panes.

•

Views—displays video from a pre-defined set of cameras.

See the “Viewing Camera Video in a Multi-Pane Grid” section on page 2-4
4

Camera Search—Enter a full or partial camera name to display a list of matching devices.

5

Locations—Select the location to view the cameras assigned to that location.

6

Selected Location.

7

Cameras available for the selected location. Drag and drop camera names onto the available panes, or highlight a pane
and double-click the camera name.

Cisco Video Surveillance Manager Safety and Security Desktop User Guide
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8

Video Pane. See the “Controlling Video Playback” section on page 4-1 for instructions to control playback of live or
recorded video.

9

(Read-only) The selected View and/or Video Wall.

Procedure
Step 1

Select the Camera Centric Workspace tab

Step 2

Click the Views menu and select one of the following options:

Step 3

.

•

Blank—displays a blank matrix of video panes.

•

Views—displays video from a pre-defined set of cameras.

(Optional) Select a video source (camera) for each pane:
a.

Search for a camera name or select a location.

b.

Drag-and-drop camera names onto the available viewing panes (you can also highlight a pane and
double-click the camera name).

Step 4

Use the video playback controls as described in the “Controlling Video Playback” section on page 4-1.

Step 5

(Optional) Double-click a video pane to fill the Cisco SASD viewing area with that video (Figure 2-2).
A preview of the other video panes is shown in a smaller grid at the bottom of the screen. Double-click
the video pane again to return the grid to normal size.

Tip

To fill the screen, right-click the image and select Full screen mode.
Figure 2-2

Enlarge a Video Pane
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Viewing Camera Video in a Multi-Pane Grid
Use the Camera Centric

or Video Centric Workspace

to view video in a grid.

Procedure
Step 1

Open the Camera Centric or Video Centric Workspace tab.

Step 2

From the Views menu, select a Blank layout or pre-defined View (Figure 2-3).

Step 3

Drag cameras onto the available panes to change the video source.
Figure 2-3

Tip

Views Menu in the Camera Centric Workspace

•

See the “Displaying a Video Grid on a Separate Monitor” section on page 2-5 to create a separate
window of video panes.

•

See the “Creating a Video Wall” section on page 2-8 to use pre-defined video grids that are displayed
on multiple workstations.

•

See the “Configuring Unattended Windows” section on page 3-1 for instructions to set up a
workstation for viewing only. Unattended workstations can be operated without a mouse, keyboard,
or other user input.
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Displaying a Video Grid on a Separate Monitor
A Video Grid is a multi-pane matrix of video that does not include side-bar menus. To create a video
grid, select the Video Centric Workspace tab
(Figure 2-4) and select a pre-defined View.
Figure 2-4

Video Centric Workspace
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Displaying a Video Grid on a Separate Monitor

You can also click the duplicate icon
to create a separate Video Grid and then drag cameras onto the
panes from the first window (Figure 2-5). The Video Grid maximizes video viewing space.
Figure 2-5

Creating a Separate Video Grid Window

Tip

•

Dragging cameras to the video panes is only required in blank Layouts. The cameras in a View are
pre-defined. If you drag cameras on to a View video pane, the existing video for that pane will be
replaced by the new camera source.

•

To maximize the video screens, move the new workspace to a separate monitor and expand to fill
the entire screen.

•

Double-click a video pane to fill the Cisco SASD viewing area with that video (Figure 2-6). A
preview of the other video panes is shown in a smaller grid at the bottom of the screen. Double-click
the video pane again to return the grid to normal size.

•

To fill the screen, right-click the image and select Full screen mode.

•

See the “Controlling Video Playback” section on page 4-1 for video viewing options.

Cisco Video Surveillance Manager Safety and Security Desktop User Guide
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Figure 2-6

Double-click an Image to Cisco SASD Viewing Area
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Creating a Video Wall
Video Walls are pre-defined Views that can be displayed on multiple workstations. All workstations that
display the Video Wall will display the same set of pre-defined panes.
For example, a “Lobby Door” Video Wall includes cameras in buildings 1 through 4. Each workstation
that uses the Video Wall will display the same set of cameras. If an attendant at one workstation changes
the Video Wall view and clicks Publish To Wall, then the other workstations will also change (the
operator must have access permissions to use this feature).
Figure 2-7

Video Walls

1

Select a Video Wall

3

The selected Video Wall name.

2

The video panes displayed by the selected
Wall.

4

Publish To Wall—Click to display a different
View on all instances of the Video Wall,
including those on other workstations (if
supported).

Usage Notes
•

Video Walls are configured by system administrators using the Cisco Video Surveillance Operations
Manager browser-based administration tool. See the Cisco Video Surveillance Operations Manager
User Guide for more information.

•

Video Walls can display a populated View or a blank matrix.

•

To modify the Video Wall, drag cameras to the video panes or select a different View.

Cisco Video Surveillance Manager Safety and Security Desktop User Guide
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•

To display a different view on all other workstations that display the Video Wall, select a new View
and click Publish to Wall. If a Video Wall is configured with a Default View, the Video Wall will
revert to the default after a pre-set amount of time (such as 40 seconds).

•

See the “Configuring Unattended Windows” section on page 3-1 for instructions to set up a
workstation for viewing only. Unattended workstations that display Video Walls can be operated
without a mouse, keyboard, or other user input.

Procedure
Step 1

Open a video viewing window using one of the following options:
•

Select the Camera Centric Workspace tab.

•

Select the Video Centric Workspace tab.

•

Click the duplicate icon

and select Video Grid (Figure 2-5).

Step 2

Select a Video Wall from the Wall menu (Figure 2-7).

Step 3

(Optional) Change the displayed video:
•

Drag cameras onto the available panes (you may need to click the duplicate icon
Camera Centric Workspace to access the camera list).

•

Choose a different View.

Note

Step 4

Tip

and open a

When a pane is updated, all panes in the Video Wall will refresh, which can cause a loss of video
for a few seconds.

(Optional) Display a different View on all instances of the Video Wall (such as other workstations that
display the same Video Wall).
a.

Select a View from the View menu.

b.

Click Publish to Wall.

•

If a Default View is configured for the Video Wall, the window will revert to that Default View after
a configured amount of time.

•

The Publish to Wall option is enabled only when you select a different View in the Video Wall
window.

•

You must have access permissions for Publish to Wall. See the Cisco Video Surveillance Operations
Manager User Guide for more information.
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Configuring Unattended Windows
Refer to the following topics.
Contents
•

Overview, page 3-1

•

Requirements, page 3-2

•

Usage Notes, page 3-2

•

Launching the Unattended Windows, page 3-4

•

Configuring Unattended Workstations, page 3-5

•

Understanding Offline Mode, page 3-9

Overview
Unattended mode allows video monitoring windows to display Video Walls without access to the Cisco
SASD configuration interface.
For example:
•

Once the unattended workstation is configured, you can exit the Cisco SASD application. The
unattended screens remain open and will (optionally) re-appear when the workstation is rebooted.

•

If the keyboard and mouse are removed, the operator can view video, but cannot interact with the
video playback or configure Cisco SASD. The workstation can even be placed out of reach (such as
below a desk or in a cabinet).

•

If the keyboard and mouse remain connected, the operator can interact with the video, and close and
reopen the unattended screens (using the Unattended SASD Launcher).

•

If the workstation is rebooted, the same unattended windows will automatically reappear on the
monitor(s) in the same position.

•

You can create multiple unattended windows for display on different monitors. For example, one
monitor can display a Video Wall of all Lobby Doors, and a second monitor can display a Video Wall
that rotates the panes among all side entrances. If the workstation is rebooted, Cisco SASD
automatically relaunches the Video Walls in the same monitor positions.
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Requirements

•

Unattended mode can be set to launch automatically when the workstation is rebooted (it does not
re-launch when a user logs off and logs back on). You can also use the Unattended SASD Launcher
alias installed on your desktop to relaunch the unattended screens (the Launcher also closes any
open unattended windows, and re-launches the unattended Video Wall windows configured on the
PC).

Requirements
The following are required to configure unattended workstations:
•

Administrative user privileges on the Windows workstation.

•

An admin account in Cisco Video Surveillance.

•

You must belong to a Cisco VSM User Group with access permissions for Video Walls.

•

At least one Video Wall must be configured on the system.

•

All Video Walls used in unattended mode should be configured with a Default View in the
Operations Manager. If a Video Wall without a Default View is selected, all video panes are blank.

Note

Video Walls are configured using the browser-based Operations Manager. See your system
administrator or the Cisco Video Surveillance Operations Manager User Guide for more
information.

Usage Notes
•

If the admin account password is changed, then the unattended windows must be re-configured.

•

To change the video displayed in the Video Wall panes (such as changing the camera source), revise
the Video Wall configuration using the browser-based Operations Manager (see your system
administrator or the Cisco Video Surveillance Operations Manager User Guide for more
information). The unattended windows revert to the Video Wall’s Default View when the system is
rebooted.

•

Unattended configuration applies only to a single Cisco Video Surveillance system. If you log into
a different Cisco Video Surveillance system on the same workstation, you cannot revise the existing
unattended windows.

•

If you close the unattended windows, they will remain closed until you reboot the system (if the
Launch at Startup option is selected), or if you manually launch the unattended windows using the
Unattended SASD Launcher.

•

The unattended mode will repeatedly restart if video to all panes is lost. This can be caused by
network or system issues, or if a Video Wall without a default view is selected. This allows
unattended mode to recover when the problem is resolved. For example, if the video streams for all
panes are provided by a single Media Server, and that Media Server goes down, then the unattended
mode will restart until communication with the server is reestablished. If the Media Server fails over
to another server, then the new server will provide video streaming and the video will be displayed.

•

If the video stream is lost for one (but not all) of the video panes, unattended mode will not restart
and the pane will display an error message and icon. The video will automatically re-appear only if
the video is in unattended mode and the camera is enabled for failover.
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Usage Notes

•

Operators cannot select a different video stream in an unattended window (right-click a video pane
to select a video viewing option). See the
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Launching the Unattended Windows

Launching the Unattended Windows
After the unattended windows are configured (as described in the “Configuring Unattended
Workstations” section on page 3-5), you can display the windows using one of the following methods:
Option 1: Launch At Startup

Select the Launch At Startup option when defining the unattended windows.
Figure 3-1

Launch At Startup

To change the Launch at Startup option, reconfigure the Unattended Mode as described in the
“Configuring Unattended Workstations” section on page 3-5.

Note

Unattended windows will not re-launch when a user logs off and logs back on. The windows re-launch
only when the workstation is rebooted.
Option 2: Double-click the Launcher Icon

Double-click the “Cisco Unattended Safety And Security Desktop Launcher” icon on your desktop.
Figure 3-2

Launcher Icon

– Use this option to display the unattended windows without logging in to Cisco SASD.
– If any unattended windows are still open, the configuration is reset (the Launcher closes any

open unattended windows, and re-launches the unattended Video Wall windows configured on
the PC).
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Configuring Unattended Workstations
Use Cisco SASD to configure the unattended windows. You can then close the Cisco SASD application
to display only the unattended windows.
Procedure
Step 1

Connect a keyboard and mouse to the workstation.

Step 2

Launch Cisco SASD and log in to the application.

Step 3

Select File > Unattended SASD Configuration > Begin Configuration and select one of the following
options (Figure 3-3).
Figure 3-3

Note

Unattended Mode Options

Option

Description

Yes

Revise the existing unattended windows.

No

Define a new set of unattended windows.

Cancel

Exit without changes.

If creating a new configuration, the window is blank (Figure 3-4).
If revising an existing configuration, the current windows are displayed (Figure 3-5).
Unattended windows can only be defined in the Video Centric Workspace

, as shown in Figure 3-4.
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Configuring Unattended Workstations

Figure 3-4

Step 4

Select a pre-defined Video Wall (from the Wall menu) as shown in Figure 3-4. This defines the window
pane layout and video source:
•

Video Walls are configured using the Cisco VSM Operations Manager (see your systems
administrator for more information).

•

The Video Wall should include a Default View, as shown in Figure 3-5. See the “Usage Notes”
section on page 3-2.

Figure 3-5

Step 5

Blank Unattended Window (Configuration Mode)

Unattended Window With Video Wall Default View

Position the Video Wall window(s) on the workstation monitors.
The windows will re-display in the same position when the workstation is rebooted.
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Step 6

Step 7

(Optional) Create additional unattended windows.
a.

Select the duplicate icon
and select Video Grid to create additional windows for the unattended
mode. The unattended windows must be created using a Video Grid window.

b.

Repeat Step 4 through Step 5 to select a Video Wall for each unattended window and position the
window on the workstation display(s).

Select or deselect Launch at Startup (Figure 3-6) to launch unattended mode when the workstation is
restarted.
Figure 3-6

Tip

Step 8

Launch At Startup

If deselected, the unattended windows will not appear when the workstation is restarted. Use the
Launcher to open the unattended windows. See the “Launching the Unattended Windows”
section on page 3-4.

Save the configuration: select File > Unattended SASD Configuration > Finish Configuration
(Figure 3-7).
Figure 3-7

Save the Unattended Mode Configuration
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Step 9

Step 10

Tip

Move the Cisco SASD window to display any unattended mode windows placed directly behind
the Cisco SASD window, if necessary.

Note

If no Video Walls were selected in the unattended windows, the confirmation message says “0
Video Walls” were saved. No windows will appear. But if the selected Video Wall was
configured to include a blank pane (no camera was selected as a video source in the Operations
Manager), then the Video Wall will be saved to unattended mode. However, the unattended
window will be repeatedly re-start since video streaming is not available (see the Requirements
and Usage Notes for more information).

(Optional) Exit the Cisco SASD application (File > Exit).
•

Exit the Cisco SASD application so the operator cannot configure video features or access the Cisco
SASD workspaces.

•

The unattended workstation window(s) will remain open unless you manually close them.

•

You must re-launch Cisco SASD to make additional changes to the unattended mode, if necessary.

(Optional) Remove the keyboard and mouse.
•

If the keyboard and mouse are removed, the user can only view video.

•

Leave a mouse (and/or keyboard) attached to allow the user to control video playback (see the
“Controlling Video Playback” section on page 4-1).
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Understanding Offline Mode
Offline mode allows unattended screens to continue to display video if the network connection to
Operations Manager is lost, but the connection to the cameras’ Media Servers is still available. This can
occur due to a network failure, or when the Operations Manager used to configure the system is located
at a remote location.

Note

If the window is in Offline mode, changes by another user to the Video Wall or View not updated until
the window returns to Online mode.
“Offline” appears in the window title bar when the unattended window is operating in offline mode
(Figure 3-8).
Figure 3-8

Offline Unattended Window

•

If the network connection to the Operations Manager is lost, the unattended windows will relaunch
in offline mode.

•

If the Operations Manager is unavailable when the unattended windows launch, the unattended
windows will restart in offline mode.
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Transition Times

The Unattended windows periodically check for Operations Manager connectivity, and automatically
switch between online and offline mode, if necessary. The system performs this check periodically to
avoid switching back and forth if a intermittent network issue occurs (such as a jitter).
Table 3-1

Online/Offline Transition Times

Transition

Description

Online to Offline

If the Operations Manager connection is lost for 4 minutes, the unattended
windows will switch to Offline mode.

Offline to Online

If the Operations Manager connection is restored for 12 minutes, the
unattended windows will switch to Online mode.
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Controlling Video Playback
Each video viewing pane in a Cisco Video Surveillance monitoring application supports the following
controls and features.
The features available on your workstation depend on the following:
•

The camera and system configuration.

•

Your user account access permissions.

•

The features supported by the video monitoring application.

Contents

Refer to the following topics for more information.
•

Overview, page 4-2

•

Viewing Live Video, page 4-3

•

Viewing Recorded Video, page 4-6

•

Creating, Viewing and Managing Video Clips, page 4-11

•

Using Record Now, page 4-18

•

Using the Pop-Up Menu, page 4-19

•

Understanding Video Pane Border Colors, page 4-21

•

Using the Smooth Video Options When Viewing Live Video, page 4-21

•

Synchronizing Video Playback in Multiple Panes, page 4-23

•

Using Pan, Tilt, and Zoom (PTZ) Controls, page 4-26
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Overview
To view live and recorded video, log on to the monitoring application and drag and drop camera names
onto the available viewing panes (you can also select a pane and double-click the camera name). Use
Views to view multiple panes in a single window.
For example, Figure 4-1 shows a multi-pane view using the Cisco Video Surveillance Safety and
Security Desktop (Cisco SASD) application.
Figure 4-1

Multi-Pane View using the Cisco Video Surveillance Safety and Security Desktop

Each viewing pane includes various controls that allow you to do the following:
•

Switch between live and recorded video.

•

Select the playback timespan.

•

Pause, play, or skip forward and back.

•

Create and save video clips from recorded video

•

Mute or un-mute the audio (if available).

•

Synchronize the playback of multiple recordings.

•

Control the Pan Tilt and Zoom (PTZ) movements of a camera (if supported by the camera).

•

Additional options are available by right-clicking the image. Options include synchronizing
multiple viewing panes, recording live video, expanding the image to fill the screen, creating a
snapshot image, and configuring smooth video options to improve playback performance when
network performance is poor.
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Note

The available controls depend on the camera model and system configuration. For example,
pan-tilt-zoom (PTZ) controls are available only on cameras that support PTZ. Recording options are
available only if the camera is configured to record video. Synchronized playback is available for
recorded video (not live video). See your system administrator for more information.

Viewing Live Video
Live video is displayed by default when you log in to the viewing application. Figure 4-2 summarizes
the controls available in each viewing pane.

Tip

Note

To control the playback in multiple video panes, Shift-Click or Ctrl-Click to select the panes. The
borders of all selected panes turn to orange. Controls and actions performed in one pane also affect the
other selected panes. To deselect panes, select a single pane, or use Shift-Click or Ctrl-Click to
deselect the panes

•

Live video may be delayed 1-2 seconds. Live video can be further delayed if the smooth video option
is enabled. See the “Using the Smooth Video Options When Viewing Live Video” section on
page 4-21 for more information.

•

Soft-deleted cameras (shown with a
icon) are cameras that were removed from the system but
still allow access to the camera’s recorded video. You cannot display live video from soft-deleted
cameras.

•

The control bar and audio icon will not display if your workstation monitor is set to 16-bit color
setting. Change your monitor color setting to 32-bit.
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Video Pane Controls

1

Camera name—The source of the displayed video.

2

Indicates the quality of the primary live video stream. If the live video quality is poor.
iFrame video stream can be automatically applied.

, an alternative secondary or

See the “Using the Smooth Video Options When Viewing Live Video” section on page 4-21 for more information.
3

Indicates live or recorded video (recorded video displays a time stamp such as

4

Range Bar—Used with recorded video (see the “Viewing Recorded Video” section on page 4-6 for more information).

5

Seek—Used with recorded video to choose a playback time (see the “Viewing Recorded Video” section on page 4-6 for
more information).

6

The green

7

Live video playback controls.

icon indicates live video. Click the icon to switch to the recorded view

•

—Pause the video playback.

•

— Play the video forward at normal speed.

Note

8

).

.

The other playback controls are used with archived video only. See Figure 4-3 on page 4-7 for more
information.

—Click the triangle to pin the control bar to the screen, or auto-hide the bar when the cursor is moved.
Note

The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change
your monitor color setting to 32-bit.
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Video image.

10 Camera menu.
Right-click the image to open the menu and select an option. Options not supported by the camera are disabled (shown
in gray). See the “Using the Pop-Up Menu” section on page 4-19 for more information.
11

Control icons.
•

—Audio. The audio icon appears if the camera supports audio. Click the icon to enable
audio volume. This control does not affect recorded video.

•

—PTZ. Click to enable
or disable
the Pan, Tilt and Zoom (PTZ) controls. See the “Using Pan, Tilt, and
Zoom (PTZ) Controls” section on page 4-26.

•
Note

or mute

live

— See the “Synchronizing Video Playback in Multiple Panes” section on page 4-23.
The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change
your monitor color setting to 32-bit.
Additional Information

Refer to the following topics for additional options:
•

Using Record Now, page 4-18

•

Using the Pop-Up Menu, page 4-19

•

Using the Smooth Video Options When Viewing Live Video, page 4-21

•

Synchronizing Video Playback in Multiple Panes, page 4-23

•

Using Pan, Tilt, and Zoom (PTZ) Controls, page 4-26
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Viewing Recorded Video
You can view recorded video from a continuos loop, for a motion event, or from a video clip. The camera
must be configured to support each of these options, and you must have access to a video viewing
application that supports these functions (some applications are used for viewing only).
For example, a camera can be configured to record the following:

Tip

•

Continuous recordings that include video from a set amount of time, such as the past 60 minutes.

•

Motion event recordings that are triggered whenever a motion event occurs. Video is recorded when
the motion occurs, and for a configured number of seconds before and after the event. Use a video
viewing application (such as the Cisco Video Surveillance Safety and Security Desktop) to view
motion event video.

To control the playback in multiple video panes, press Shift-Click to select multiple concurrent panes,
or Ctrl-Click to select individual panes. The borders of all selected panes turn to orange. Controls and
actions performed in one pane also affect the other selected panes. To deselect panes, select a single
pane, or use Shift-Click or Ctrl-Click to deselect the panes
Usage Notes
•

Multi-pane video clips can also be saved to your desktop and played using the Cisco Video
Surveillance Review Player.

•

If the Record Now feature is enabled, right-click the image and choose Record Now to record live
video.

•

If a camera is soft-deleted, you can still access the camera’s recorded video but cannot display live
video. Recordings are retained on the system until removed according to the recording retention
settings.

•

Click the
icon to toggle between live and recorded video. The
video is displayed.

•

The first time you select a camera’s recorded video, the playback begins slightly behind the live
(current) time. When you toggle between live and recorded, recorded video returns to the previously
selected timestamp.

icon appears when recorded
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Figure 4-3 describes the main recording features and controls.
Figure 4-3

Viewing Recorded Video

1

Camera Name—Source of the recorded video.

2

Indicates the video quality, which can be affected by network and system performance. The icon turns red if the video
quality is poor .
This icon is for informational purposes only when displayed with recorded video (the Smooth Video options do
not apply).

Note

3

Pop-up menu options. See the “Using the Pop-Up Menu” section on page 4-19.

4

Timestamp for the currently displayed video image. For example:
Changes to

Note

5

.

when live video is displayed.

Range Bar—The span of video to work with.
•

The entire range bar represents the entire span of available recorded video. Slide the range bar selectors to shorten
the range (see below).

•

The lower (green) seek bar represents the selected range (see below).

Cisco Video Surveillance Manager Safety and Security Desktop User Guide
OL-27379-06

4-7

Chapter 4

6

Controlling Video Playback

Range Bar selectors—Drag the range bar selectors to narrow the timespan of video you want to review.
For example, drag the selectors to create a 10 minute range. You can then drag that range left or right to the appropriate
place in the recorded span.
In the following example, the entire range of recorded video is selected (the range bar selectors are to the far right and
left). To display the timestamps, click a selector.

Click and drag the range bar selectors to choose a shorter period of time. In the following example, the range bar
selectors are used to select approximately 10 minutes of video. Drag the selected range left or right to locate the desired
range of recorded video.

7

Tip

The green seek bar represents the selected span. If the span in the top range bar is 10 minutes, then the green
seek bar represents 10 minutes of video. Slide the seek bar selector to choose the playback time (see below).

Tip

Double-click a range bar selector to playback the video from the beginning of that range.

Seek Bar —Represents the video range, and is used to select a playback time.
For example, if the range is 10 minutes, then the seek bar represents 10 minutes of video.

8

Tip

Right-click the seek bar and select Seek to... to select a specific date and time.

Note

Gaps in the recorded video are shown in gray. Recording gaps occur if there is a manually-triggered Record
Now session, if recording was manually stopped, if recording was stopped by a schedule, or if video was
unavailable due to network connectivity issues, device malfunctions, or other events.

Seek Bar selector—Drag the selector to play video from the selected time (as indicated by the timestamp).
Note

When you move the scroll bar for a video pane that is synchronized, that pane becomes the new synchronization
master pane. The other synchronized panes play video according to the master pane. See the “Synchronizing
Video Playback in Multiple Panes” section on page 4-23.
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Bookmarks—Create bookmarks to save a video clip or a repeating segment (see below).
To create a bookmark, Ctrl-Click-drag the seek bar. The bookmark span is shown in orange.

10 Bookmarks menu—Right-click the seek bar to display the bookmark menu. You can save the bookmarked video as a
clip in one of the supported formats, remove all bookmarks, or create a repeating segment.

See the following for more information:
•

Creating, Viewing and Managing Video Clips, page 4-11

•

Creating a Repeat Segment, page 4-17

11 Indicates live or recorded video. Click the icon to switch between live and recorded video.
•

—Live video is displayed.

•

—Recorded video is displayed.

Tip

The first time you select a camera’s recorded video, the playback begins slightly behind the live (current) time.
When you toggle between live and recorded, recorded video returns to the previously selected timestamp.

12 Recorded video playback controls.

•

—Step Reverse button—(Archived video only) Pauses the playback and steps back one frame at a time.

•

—Play Reverse button—(Archived video only) Plays the video archive in reverse at normal speed.

•

—Pause button—Pause the video playback.

•

—Play Forward button—Play the video forward at normal speed.

•

—Step Forward button—(Archived video only) Pauses the playback and steps forward one frame at a time.

Variable Speed Playback

Right-click the Play Reverse

or Play Forward

button to play the video slower or faster.

For example, select 0.50X to play the video at half speed (forward or reverse). Select 4.00X to play at 4 times the normal
rate (forward or reverse).
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—Click the triangle to pin the control bar to the screen, or auto-hide it when the cursor is moved.
Note

The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change
your monitor color setting to 32-bit.

14 Camera feature icons. For example:
•
•

or

—Audio is supported by the camera and enabled or disabled in the viewing pane.

—The synchronization icon appears in video panes that play synchronized video. See the “Synchronizing Video
Playback in Multiple Panes” section on page 4-23.

Note

The PTZ icons are enabled only for live video.

Note

The control bar and audio icon will not display if your workstation monitor is set to 16-bit color setting. Change
your monitor color setting to 32-bit.
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Creating, Viewing and Managing Video Clips
Video clips can be created in multiple formats for playback using the Cisco VSM Review Player, or a
third party player.

Timestamps are not displayed in 3rd-party video viewers. Use the Cisco Review Player to
display timestamps (see the Cisco Video Surveillance Review Player User Guide for more
information).

Note

This section includes the following topics:
•

Supported File Formats, page 4-11

•

MP4 Video Clip Usage Notes, page 4-12

•

Creating Video Clips, page 4-12

•

Viewing and Downloading MP4 Clips, page 4-15

Supported File Formats
Cisco Video Surveillance supports the creation and playback of the following video formats:
Table 4-1

Video Clip File Formats

File Format

Description

MP4

A standard video file format that is playable on most computers and useful for sending to 3rd parties. MP4
clips support a single video pane and can include audio (CVA/CVX files do not support audio). MP4 clips
are saved on the server for 7 days and must be downloaded using the Select Streams and Clips menu or
the or Clip Search option.
Notes

CVA

•

MP4 clips are automatically deleted from the server 7 days after creation. Download the clips to a local
drive if necessary (see the “Viewing and Downloading MP4 Clips” section on page 4-15).

•

MP4 audio playback is supported only with the Cisco VSM Review Player or VLC media player.

•

Use the Cisco VSM Review Player to save MP4 files in the tamper proof MPX format. See the Cisco
Video Surveillance Review Player User Guide for more information.

Cisco video archives (CVA) can include multiple video panes that synchronize to the same time. CVA files
can only be opened in applications that support the CVA format (such as the Cisco Review Player).
CVA files do not support audio playback.

CVX

A tamper proof CVA file. CVX files require a password that is entered when the file is created. You must
enter the password to open and view the video file. CVX video playback will shut down if the file is
tampered with.
CVX files do not support audio.

Tip

You can also right-click a video pane and select Take Snapshot to save a still image in BMP,
JPEG, PNG, and TIFF formats. See the “Using the Pop-Up Menu” section on page 4-19 for more
information.
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MP4 Video Clip Usage Notes
MP4 clips are saved on the server. Review the following notes to manage the server-side clips.

Note

CVA/CVX clips are downloaded immediately and not stored on the server.
•

MP4 clips are automatically deleted after 7 days.

•

MP4 clips require that the clipping repository be selected on the Media Server associated with the
camera. See the “Partition Settings” section on page 7-4.

•

If using the Operations Manager browser interface, you can also use Clip Search to view, download
and delete MP4 clips saved to the server. See the “Clip Search (View, Download and Delete MP4
Clips)” section.

•

You can create up to five MP4 clips at a time per Media Server.

•

Users can only delete their own clips. Users that belong to a User Group with Camera permissions
can also delete other users’ clips.

•

If the clipping fails, see your system administrator for assistance.

•

MP4 clips play automatically in the pane when downloaded. The clips can also be viewed using the
Cisco VSM Review Player or VLC media player.

Creating Video Clips
To create video clips, create a bookmark span and select the file format, as described in the following
procedure.
Requirements
•

You must belong to a User Group with Export Recordings permissions to create, view or download
video clips.

•

The Media Server hard disk volume must have sufficient disk space to create the video clip or the
operation will fail. See your system administrator for more information.

Procedure
Step 1

Select a video pane from the viewing application (such as Cisco SASD or Operations Manager).

Tip

To create a multi-pane clip in the CVA format, press Shift-Click to select multiple concurrent
panes, or Ctrl-Click to select individual panes.

Step 2

In the green seek bar, Ctrl-Click and drag the mouse cursor to create a bookmark span. The bookmark
span is shown in orange (Figure 4-4).

Tip

In recording mode
, you can also right-click the image and choose Select Clip Range from the
pop-up menu (see the “Using the Pop-Up Menu” section on page 4-19). A 10 minute clip range is
automatically selected starting from current thumb position, and the range bar is automatically scaled to
1 hour.

Step 3

Right-click the bookmark and select an option to create a file in the desired format (Figure 4-4).
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Figure 4-4

Creating a Video Clip

.

Step 4

Save the file:
CVA/CVX files
a.

(Optional) Revise the start and end date and time (Figure 4-5). Enter a time between 30 seconds and
4 hours (the range cannot include more than one codec and the start time must be before the end
time).

Figure 4-5

CVA Clip Settings

b.

(Optional) Select Enable tamper proof and enter a password to create a password-protected CVX
file.

c.

Click OK.

d.

Select a location on a local disk and click Save.

e.

Wait for the clip to be generated and downloaded. Video streaming is paused during CVA/CVX clip
generation.
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MP4 clips
a.

(Optional) Revise the start and end date and time (Figure 4-6). Enter a time between 30 seconds and
4 hours (the range cannot include more than one codec and the start time must be before the end
time).

Figure 4-6

b.

(Optional) Enter a clip name that identifies the recording on the server (Figure 4-7). For example, if
you enter “My 4500 Camera” then the clip selection will be “My 4500 Camera___1347005138141”.
If blank, the default name is “My Clip__system-timestamp”.

c.

(Optional) Select or deselect Record Audio (if the camera supports audio recordings) to include or
exclude audio. Audio playback is supported only with the Cisco VSM Review Player or VLC media
player.

d.

Click OK to save the clip to the server.

Tip

Step 5

MP4 Clip Settings

Right click the image and select Get clip status to view the current status: In-Progress,
Completed or Failed. Use the Clip Search option to view, download, delete and manage MP4
clips saved on the server.

Download and play the clip as described in the “Viewing and Downloading MP4 Clips” section on
page 4-15.
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Viewing and Downloading MP4 Clips
You can right-click a video pane and choose Select Streams and Clips to save and play MP4 clips. The
clip remains on the server for 7 days after it was created.

Tip

If using the Operations Manager browser interface, you can also use Clip Search to view, download and
delete MP4 clips saved to the server. See the “Clip Search (View, Download and Delete MP4 Clips)”
section.

Note

See the “MP4 Video Clip Usage Notes” section on page 4-12 for more information.
Procedure

Step 1

Right-click the video pane and choose Select Streams and Clips (Figure 4-7).

Step 2

Select the Clip file.
Figure 4-7

Note

Accessing a MP4 Clip

Clips are automatically deleted from the server after 7 days.

Step 3

Enter a file name and location.

Step 4

Click Save and wait for the clip to download.

Step 5

The clip will automatically play in the pane the fist time it is downloaded (Figure 4-8). To view the clips
again, use a viewing application such as the Cisco Review Player.
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1

Controlling Video Playback

MP4 Clip Viewing Pane

MP4 file name and location

2

Timestamp for currently displayed image.
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Creating a Repeat Segment
A repeating segment is a range selected on a recording that plays continuously in a loop. When the end
of the segment is reached, playback starts over from the beginning of the segment. The video segment
loops indefinitely until you cancel the segment or seek video outside the selected range (seeking inside
the selected range does not cancel the segment).
Figure 4-9

Note

Create a Repeating Segment

Repeating segments are used with recordings only.
Procedure

Step 1

Ctrl-Click-drag the seek bar in a recording to create a bookmark (Figure 4-9).
The bookmark span is shown in orange.

Step 2

Right-click the seek bar and select as a repeat segment.

Step 3

(Optional) Enter a specific start and end date and time.

Step 4

To cancel the segment, right click the segment and choose Remove all Bookmarks.
You can also click on the seek bar outside the selected range.
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Using Record Now
To manually trigger recording of a live video stream, right-click the image and choose Record Now.
Requirements
•

The Record Now option must be enabled for the camera configuration in the Operations Manager.

•

Your use account must include access permissions to view recorded video.

•

You can record video from the live primary video stream only.

Usage Notes
•

Audio is not recorded.

•

Video is recorded for a system-defined length of time (the default is 5 minutes).

•

The recording is retained on the system according to the event retention settings for the camera. For
example, if the camera’s event recordings are retained for 30 days, then the Record Now recordings
will also be available for 30 days. When the retention time is exceeded, the recording is
automatically deleted (see the “Creating, Viewing and Managing Video Clips” section on page 4-11
to save the video to a separate file).

Procedure
Step 1

Log in to the video viewing application and select a camera.

Step 2

Choose live video

Step 3

Right click the image and choose Record Now (Figure 4-10).

(see the “Viewing Live Video” section on page 4-3).

•

The recording is performed in the background. You can continue to use the other playback controls.

•

The recording status is displayed in red text (Figure 4-10) when the recording time nearly complete.

Figure 4-10

Record Now
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Step 4

To view the recorded video, review the following notes.
•

Record Now clips are available from the primary stream only. Right click the image and choose
Select Streams and Clips to view the recorded primary stream (disabled if the pane is
synchronized).

•

If the video is within the time span of other recorded video, there is no separate indication of the
Record Now video. You can access the video as described in the “Viewing Recorded Video” section
on page 4-6).

•

If the Record Now video is older than the continuous loop, the gap between the recording times is
shown in gray:

Note

When the event retention time is exceeded, the Record Now recording is automatically deleted.
To save the recording, see the “Creating, Viewing and Managing Video Clips” section on
page 4-11.

Using the Pop-Up Menu
Select a video pane and right-click on the image to open a menu with the following options (see
Figure 4-2 on page 4-4).
Table 4-2

Camera Pop-Up Menu (Right-Click the Video Image)

Camera Menu Item

Description

Pan, Tilt, and Zoom

(Live video only) Open the PTZ preset list that allows you to quickly adjust the camera view.
See the “Using Pan, Tilt, and Zoom (PTZ) Controls” section on page 4-26

Digital zoom

Digitally enlarges the image to zoom in on a specific area.
Double click the enlarged image to use a window-in window view. Adjust the viewing area in
the small window to define the portion of enlarged video to display.
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Camera Pop-Up Menu (Right-Click the Video Image) (continued)

Camera Menu Item

Description

Sync selected panes with
this pane

Synchronizes the playback from multiple video panes to the same time.
•

After a pane is synchronized, the menu item changes to Remove this pane from sync.

•

To synchronize additional panes, right-click an un-synchronized pane and select Add
selected panes to sync.

See the “Synchronizing Video Playback in Multiple Panes” section on page 4-23.
Full screen mode

Enlarges the video image to fill your display screen.
Tip

To exit, press Esc, or right-click and choose Full screen mode again.

Take snapshot

Saves a snapshot of a single video pane (excluding control icons, timestamps and other
information) in BMP, JPEG, PNG, or TIFF format.

Take composite snapshot

Saves a snapshot of all panes in a multi-pane layout (including control icons, timestamps and
other information) in BMP, JPEG, PNG, or TIFF format.

Record now

(Live video only) Immediately begins recording video.
See the “Using Record Now” section on page 4-18 for more information.
Note

The Record Now option must be enabled in the camera configuration.

Audio settings

(Cameras with audio support only). Opens a window used to adjust video playback volume and
balance.

Smooth video settings

(Live video only) Creates a smooth video playback if the playback is choppy or delayed due
to network or other performance issues.
See the “Using the Smooth Video Options When Viewing Live Video” section on page 4-21.

Global settings

Provides settings that apply to all video panes. For example: UI transparency and zoom video
to fit the pane.

Select Streams and Clips

Allows you to select the live and recorded video streams (primary or secondary) supported by
the camera.
Note

Select clip range

Select Streams and Clips is disabled when the pane is synchronized. See the
“Synchronizing Video Playback in Multiple Panes” section on page 4-23 for more
information.

(Archive video only) Selects a 10 minute clip range starting from current thumb position. The
range bar is automatically scaled to 1 hour.
See the “Creating, Viewing and Managing Video Clips” section on page 4-11 for more
information.

Get clip status

Shows the current status of MP4 clips: In-Progress, Completed or Failed.
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Understanding Video Pane Border Colors
The color that surrounds a video pane indicates the status of the video in that pane. For example, when
you click anywhere in a video pane, the pane becomes active and the border changes to orange. The
controls and actions performed apply to the active pane.
Table 4-3 describes the meaning of each color.
Table 4-3

Video Pane Border Colors

Color

Description

Gray

The pane is not highlighted. All panes have a gray border by default.

Orange

The pane is selected as the active pane, and the controls and actions apply to
that pane. If multiple panes are selected as active panes, the controls and
actions performed on one pane apply to all active panes.

Using the Smooth Video Options When Viewing Live Video
If live video playback is choppy due to network or other performance issues, use the Smooth video
settings to automatically do the following:
•

Create a video data buffer (in seconds) that delays live playback while video data is cached. Live
video can then be played back smoothly despite network delays between the camera, Media Server,
and workstation.

•

Automatically switch to a different stream if the live video quality is poor.

Icon Colors

The video quality icons in each pane indicate the following:
•

Green

indicates everything is fine.

•

Yellow

•

Red
indicates a severe adverse situation. Action will be taken to correct the situation, such as
switching to secondary stream or iFrame streaming.

indicates that the client workstation has detected the play back is not smooth.

Usage Notes
•

The Smooth Video Options are available only for live video on non-PTZ cameras (the Smooth Video
Options are automatically disabled on PTZ cameras).

•

The settings are applied to all non-PTZ cameras and are persistent for the current PC workstation.
For example, the settings will remain if you log out and back in, or view a different camera and then
return to the current camera.

•

The settings also apply to the non-PTZ cameras when using the Cisco Safety and Security Desktop
(SASD) application and the Cisco Video Surveillance Management Console.

•

The Smooth Video options are disabled if you manually select a stream (right-click a video pane and
choose Select Streams and Clips). The pane will display the selected stream even if the video
quality is poor (the video will not automatically switch to the Smooth Video alternative stream). To
cancel the manually selected stream and re-enable the Smooth Video settings, reload the view or
drag and drop the camera again.

•

If a video stream is selected from a redundant media server, the Smooth Video option is disabled
(the camera will not use a secondary stream even if the video quality icon is red).
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Procedure
Step 1

Right-click a live video image to open the pop-up menu.

Step 2

Select or deselect Enable Smooth Video for Live non-PTZ Camera to enable the smooth video
options.

Step 3

(Optional) Enter the Preroll Buffer Size in Seconds to define the number of seconds that live video will
be delayed.
Video data is saved in a cache on your PC to avoid pauses caused by network bandwidth and other issues.
We recommend a value between 1.5 and 3 seconds.

Caution

Step 4

Note

We strongly recommend that the Preroll Buffer be disabled (enter 0 or leave the field blank) since
streaming delays can cause a potential security risk. We recommend that you address the network
bandwidth or performance issues causing the delays. Use the Preroll Buffer only when significant
stuttering occurs and a network resolution is not available.
Use the Smooth Video Options to define an alternative video stream that will be used if video quality
is poor despite the smooth video buffer (video quality is indicated by the
icon on the live viewing
pane).
•

Secondary Stream—(Only if configured on the camera) If the live video quality is poor , the
secondary video stream is used. Secondary streams typically present a lower-quality image that
requires less bandwidth and processing.

•

I frame only—If the live video quality is poor , then only the iFrame video is displayed. iFrame
video reduces the bandwidth requirement to correct the situation.

•

None—If the live video quality is poor , no change is made and the selected stream is displayed
even if it results in choppy or paused playback.

•

These options are not used if the video quality is acceptable
or if the icon is yellow
(intermediate)
. The selected stream is displayed normally.

•

A down arrow

•

If an alternative stream is applied, the settings remain until you close and reopen the video source
(camera).

is displayed when the secondary or iFrame stream is applied.
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Synchronizing Video Playback in Multiple Panes
To synchronize video playback from multiple panes, select multiple panes, right-click the pane that
defines the master time, and choose Sync Selected Panes With This Pane. All panes will play video
from the same date and time.
Usage Notes
•

All panes will play forward when synchronization begins, even if one or more of the panes was
playing in reverse.

•

Synchronization for recorded video is performed only if the time in the selected panes overlap. If
the time for a video pane does not overlap with the master pane, the pane is excluded from
synchronization.

•

When you move the scroll bar for a video pane that is synchronized, that pane becomes the new
synchronization master pane. The other synchronized panes play video according to the new master
pane.

•

If the seek controls are used to search video, the other synchronized panes pause until the seek
completes, then continue to display video that is synchronized with the new master pane time.

•

You can switch the synchronized panes between live and recorded video.

•

To remove a pane from the synchronized playback, right-click the pane and choose Remove This
Pane From Sync to remove it.

•

To add un-synchronized panes, right-click the pane and choose Add selected panes to sync.

•

The Select Streams and Clips menu item is disabled when a pane is synchronized.

•

When 16 video panes are synchronized, some live video panes may appear to be not synchronized
if the video stream is configured for the following:

Format

Resolution

Framerate

JPEG

640x480

30 fps

H-264

1920x1080

30 fps
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Figure 4-11 describes the main synchronization attributes.
Figure 4-11

1

Synchronized Playback of Recorded Video

—The synchronization icon appears in the video panes that display synchronized video.

2

The timestamp for synchronized video is the same.

3

Roll over a synchronized pane to display the playback controls. Changes to any pane are mirrored by the other
panes.

4

Unsynchronized panes can continue to display live or recorded video.
To add a pane to the synchronized group, right-click the pane and select Add selected panes to sync.
Procedure

To play recorded video from multiple video panes synchronized to the same time, do the following:
Step 1

Select a layout or pre-defined view from the View menu.

Step 2

Shift-click or Control-click to select multiple video panes for synchronization.
The selected panes are displayed with a light yellow border.
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Step 3

Right-click a video pane and select Sync Selected Panes With This Pane from the menu.
The selected pane becomes the master pane.

Step 4

(Optional) To remove a pane from the synchronized group, right-click the pane and choose Remove This
Pane From Sync.

Note

Step 5

The pane continues to play video from the same timestamp, but the video can be stopped or
altered without affecting the other panes.

(Optional) To add un-synchronized panes, right-click the pane and choose Add selected panes to sync.
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Using Pan, Tilt, and Zoom (PTZ) Controls
Cameras that support pan, tilt and zoom (PTZ) movements display a PTZ icon

Tip

•

To pan and tilt, left-click the image (the movement icons
up and down.

•

To zoom, use the scroll wheel to zoom in and out.

.

appear) and drag the mouse right, left,

To use a USB joystick, see the “Calibrating a Joystick for Windows 7” section on page 4-28.
In addition, PTZ presets allow the camera to quickly jump to a preset position. For example, a PTZ preset
could zoom in on a doorway, or pan to the opposite end of a parking lot. PTZ presets can be triggered
using a mouse, joystick or automatically triggered event.

Note

Cameras can also be configured with PTZ tours that automatically cycle between PTZ preset positions.
You can interrupt the tour using the PTZ controls, and the tour will resume after a set amount of time.
See your system administrator for more information.
Figure 4-12 summarizes the controls and information available on each PTZ camera viewing pane.

Figure 4-12

Camera PTZ Controls

1

Selected Camera

3

PTZ Enabled/Disabled Icon (click to toggle)

2

PTZ is available in Live mode only

4

PTZ Preset Menu (right-click to access)

Usage Notes
•

PTZ movements are available only when viewing live video.
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•

PTZ can only be enabled for a single video pane if multiple panes are displayed. See the “Using PTZ
Controls When Multiple Video Windows are Displayed” section on page 4-29.

•

You must also belong to a user group with Perform PTZ permissions.

Procedure

To control a camera’s PTZ movement or trigger a PTZ preset position, do the following:
Step 1

Step 2

Display the live video from a PTZ-enabled camera:
a.

Click Monitor Video.

b.

Expand the location tree and select the camera.

c.

Highlight a video pane and double-click a camera name.

Verify that the PTZ controls are enabled:
•

—PTZ controls are supported by the camera and enabled in the viewing pane.

•

—PTZ controls are disabled. Click the

Note

Step 3

icon to enable PTZ controls.

If a higher-priority user is using the PTZ controls, the PTZ controls remain locked and you
cannot control the PTZ movements until released by the higher priority user.

To move the camera position, use the following controls.
Using a Mouse
– Pan and Tilt—Left-click the image and drag the mouse (

) right, left, up and down.

– Zoom—Use the scroll wheel to zoom in and out.

Using a USB Joystick
– Pan—move the joystick bar horizontally.
– Tilt— move the joystick bar vertically.
– Zoom —twist the joystick.

Tip

Step 4

See the “Calibrating a Joystick for Windows 7” section on page 4-28 for information to set up a
USB joystick for the first time.

(Optional) Select a PTZ preset position.
Using a Mouse
– Right-click the image and choose Pan, Tilt, and Zoom and then Presets (Figure 4-12).
– Choose a preset to move the camera to the defined position.

Using a USB Joystick
– Press the joystick button that corresponds to the PTZ preset number.
– For example, joystick button 1 triggers PTZ preset 1, joystick button 2 triggers PTZ preset 2,

etc.
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Calibrating a Joystick for Windows 7
To use a USB joystick to control PTZ camera movements, connect the joystick to a USB port on the
client PC and calibrate the device for Window 7. You can use the software and instructions included with
the joystick, or use the built-in Windows calibration utility, as described in the following procedure.
Procedure
Step 1

Step 2

Tip

Step 3

Install and configure the USB joystick according to the manufacturer instructions.
•

See the device documentation for more information.

•

The manufacturer may also include a calibration utility that can be used instead of the built-in
Windows utility.

In Windows 7, calibrate the device using the Game Controllers control panel.
a.

Select Control Panel from the Start menu.

b.

Select Hardware and Sound.

c.

Select Devices and Printers.

d.

Double-click Game Controllers.

e.

Highlight the joystick device and click Properties.

f.

Click Calibrate in the pop-up window.

g.

Follow the on-screen instructions to complete the process.

You can also use the Windows search function: choose Search from the Start menu and enter “set up
USB game controllers” to open the Game Controllers control panel. Highlight the joystick icon and click
Calibrate. Follow the on-screen instructions to complete the process.
Click Finish or OK to close the windows.
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Using PTZ Controls When Multiple Video Windows are Displayed
When multiple viewing panes are displayed, only a single pane can have PTZ controls enabled at a time
(Figure 4-13). This prevents a USB joystick from affecting more than one pane.
•

The pane with PTZ enabled displays a
disabled.

•

Click the disabled icon
panes).

•

If a pane does not display an icon, then the camera does not support PTZ movements.

Figure 4-13

icon. The

icon indicates that PTZ controls are

to enable the controls for a pane (and disable the controls for the other

PTZ Controls in a Multi-Pane View

1

PTZ enabled viewing pane

2

PTZ disabled viewing pane

3

PTZ not supported by camera (no icon)

Note

PTZ movements are available only when viewing live video.

Tip

If multiple browser windows are used to display video, joystick PTZ commands will affect the enabled
PTZ pane in each browser window.
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Viewing a Thumbnail Summary of Video
Archives
Use Thumbnail Search to quickly locate specific scenes or events in recorded video without
fast-forwarding or rewinding. Thumbnail Search displays a range of video as thumbnail images,
allowing you to identify a portion of the recording to review.
•

Summary Steps, page 5-1

•

Overview, page 5-2

Summary Steps

To view a thumbnail summary of a camera’s recordings:

Tip

1.

Select File > Thumbnail Search to open the forensic search tool in a separate window (Figure 5-1).

2.

Drag and drop a camera from the Camera workspace onto the Forensic Thumbnail Search window.

3.

Select the a recorded video stream.

4.

Select the start and end time (duration) for the video included in the thumbnails.

5.

(Optional) Slide the range bar (“Duration”) right or left within the recording timeline.

6.

(Optional) Click a thumbnail to play video from the start time (in white text).

Double click a pane to enlarge the video.
7.

Click and drag multiple thumbnails to create a MP4 video clip, or to select a new time range (select
Zoom In).
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Overview

Figure 5-1 provides an overview of the search and display controls.
Figure 5-1

Thumbnail Window

.

1

Stream selection—Select the primary or secondary
stream.

8

Play button (hover over an image to display the button).

2

Thumbnail image size.

9

Thumbnail clip start time.

3

Thumbnail start date and time.

10 Video playback.

4

Thumbnail end date and time.

11 Shift-drag the mouse to select multiple thumbnails.
Select Create mp4 to create a video clip or Zoom In to
select a new time range.

5

Recording start time—The start for the entire video
archive.

12 Thumbnail image from the end of the time span.

6

Range Bar—Slide the bar left or right to display
13 Recording end time.
thumbnails from the video indicated by the start and end
times. Click and drag the start and end time to adjust the
duration.

7

Thumbnail clips—The top left thumbnail displays an
image from the beginning of the time span.

14 Refresh the displayed thumbnails.
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Viewing Alerts
Select the Alerts Centric Workspace
(Figure 6-2) to view system alerts, and the cameras and events
related to those alert (if available). You can also do the following:
•

Acknowledge, close, or re-open alerts

•

Add a comment, or flag the alert as a false alarm.

•

View recorded video related to an event (if available).

•

View live or recorded video from a camera shown on a location map.

Refer to the following topics for more information:
Contents
•

Understanding Events and Alerts, page 6-2

•

Alert Centric Workspace Overview, page 6-3

•

Viewing Event URLs, page 6-6

•

Common Tasks, page 6-7

•

Impact of Device Location Changes on Alerts, page 6-8

•

Summary of Events and Corresponding Alerts, page 6-9
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Understanding Events and Alerts

Understanding Events and Alerts
Events represent incidents that occur in the system and devices (such as cameras or camera encoders).
Events are aggregated (grouped) into alerts for notification purposes. For example, if a camera goes
offline, and comes back online repeatedly, all events for that issue are grouped under a single alert, which
triggers a single notification. This prevents operators from being flooded with notifications for multiple
occurrences of the same issue.
Cisco VSM generates two types of events: device health events and security events:
•

Health Events are generated when a device health change occurs, such as reachability, fan speed,
file system usage, or other device-related issues. Critical health events generate alerts by default.

•

Security Events—Events such as motion stop or start, analytics, contact closures, or soft triggers
from an external system can be configured to generate alerts, or perform other actions. Security
events do not generate alerts by default.

Figure 6-1 summarizes how Cisco VSM events and alerts are generated, aggregated, and viewed.
Figure 6-1

Health Events, Alerts, and Notifications
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Alert Centric Workspace Overview
In the Alert Centric Workspace (Figure 6-2), select an alert to view the events related to that alert, as
well as the location map, related cameras and related video. See the table following Figure 6-2 for the
options to view and manage alerts. For example, you can right-click an alert to acknowledge, close,
re-open, or comment on the alert. Double-click an event or camera icon to view live or recorded video
(if available).
Figure 6-2

1

Alert Centric Workspace

Alert Centric Workspace tab
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Alert Centric Workspace Overview

2

—All Alert or Alerts By Location tabs only.
Click the lock icon to stop or start auto-updates of the All Alert or Alerts By Location results.

3

•

When unlocked

, new alerts will be added to the list as they occur.

•

When locked
, dynamic updating is paused and only the currently displayed alerts are shown. Unlock the
display to refresh the results.

Click Filter to display a sub-set of alerts.
For example, view alerts by severity, view only open events, or only events related to system health.

4

Click Search and then Filter to select additional options such as a span of time, location, or device type.
Note

5

•

All Alerts—Displays all alerts based on the selected filters.

•

Alerts by Location—Displays alerts for the devices and resources assigned to the selected location.

Tip

6

The search results do not auto-refresh. Re-search the alerts to view current results.

The alert list will dynamically refresh unless locked

.

Click the column headers to sort the displayed alerts.
•

Only headings with an arrow are sortable.

•

In the Search tab, multiple columns are sortable.

•

In the All Alert, Alert by Location, and Map Alert tabs, only Severity and Time are sortable.
– The Time column sorts alerts with the newest alert at the top.
– The Severity column sorts alerts with the most severe alert at the top (in the order of CRITICAL, MAJOR,

MINOR, WARNING, INFO).
7

Select an alert to view the events related to that alert, as well as the location map, related cameras and related video.
Note

8

The alert severity reflects the severity of the most recently generated event. For example, if a camera becomes
unreachable and the streaming status is Critical, the alert is Critical. When the camera becomes reachable
again, and the streaming status normal event occurs, and the alert severity is changed to INFO. See the
“Summary of Events and Corresponding Alerts” section on page 6-9 for the severity of each event.

Right-click an alert to acknowledge, close or re-open the alert.
You can also add a comment to the alert or mark it as a false alarm.

9

The events associated with the alert (multiple events for the same issue are grouped under a single alarm).
Click the right and left arrows to page through the events related to the alert.

10

— If the URL icon
images.

appears, right-click the event to open a new web browser with additional information or

See the “Viewing Event URLs” section on page 6-6.
11 Select an event to view video related to a motion or analytics event, if available.
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12

—The camera icon

appears for the following event types:

– Motion start/stop
– Contact closure open/close
– Soft trigger
– Analytics
•

If video is available for the event, a preview is displayed in the lower right video pane.

•

Double-click the event to open a large video playback window.

•

If video is not available (for example, if the video was automatically deleted after the duration defined by the
camera retention rules), an error message appears when attempting to view the video.

13 Video related to a motion or analytics event, if available.
14 The location map associated with the alert.
•

If the alert is related to a camera, the camera icon is animated (in a breathing motion).

•

Double-click the camera name to enlarge the map.

•

Click and drag the image to move the map in the window.

15 Camera icon

.

•

Double-click the icon

to view live or recorded video from the camera in a pop-up window.

•

Double-click anywhere on the map to zoom the map image.

•

Right click a camera icon (or camera name) to display camera details (name, description, timestamp and stream
preview).

16 Pop-up video viewing window. Double-click a camera icon

to open the window.

Dynamic Updates of Alert Results
By default, new alerts are dynamically added to All Alert or Alerts By Location results as they occur.
New alerts will appear at the top of the list if the results are sorted by time, or in the middle of the list if
the results are sorted by severity.
Click the lock icon
to stop or start auto-updates of the All Alert or Alerts By Location results. When
locked
, dynamic updating is paused and only the currently displayed alerts are shown. Unlock the
display to refresh the results.
The Search tab results do not dynamically refresh. The alerts displayed remain static unless you perform
another search.
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Viewing Event URLs
Alerts can also include a custom URL that open a new web-browser window with additional information,
such as a image snapshot or video clip.
To open the URL, right-click the URL icon for an event, as shown in Figure 6-3.
Figure 6-3

Selecting a Soft Trigger Event URL in the Cisco SASD Monitoring Application

1

Select a soft-trigger alert that was customized to include an additional URL.

2

Right-click the URL icon for the event.

3

Select the URL.

4

View the information, image or video in the pop-up window.
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Common Tasks
Table 6-1 describes common tasks that are performed with alerts.
Table 6-1

Common Alert Tasks

Task

Description

Narrow the list of displayed alerts

Click the tabs at the top of the alert list to display:
All Alerts
Alerts By Location
Search— keywords
Filter (narrow the results based on alert type, status, or severity, time, location,
and/or device).

Display the events associated with the alert

Select an alert to view the associated events in the field below the alert list.

Acknowledge the alert

Right-click an alert and select Acknowledge.

Close, re-open, or flag the alert as a false
alarm

Right-click an alert and select an option.
•

When an alert is closed, no new events can be added (unless the alert is
reopened by a user). Any new events for the same device and issue are
added to a new alert entry.

•

Users can still modify closed alerts, including the following:
– Add a comment (the alert state is not changed).
– Re-open the alert. New events for that device and issue will be added

to the alert.
Add a comment

Right-click an alert and select Comment. Add the comment and click Apply.

View event video (motion and analytics
alerts only)

Double-click a motion or analytics event to view the video in the lower right
pane.
Double-click the event to open a new video window.

View live or recorded video from the camera Double-click a camera icon in the map pane to view video from the camera in
associated with the alert
a pop-up window.
View alerts associated with a location

View alerts on a larger location map

•

Click the Alerts By Location tab.

•

Click Filters and select the location.

•

Open the Map Centric Workspace
Alerts on Map” section on page 7-1

Open the Map Centric Workspace

. See the “Viewing Cameras and

.

See the “Viewing Cameras and Alerts on Map” section on page 7-1
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Impact of Device Location Changes on Alerts
Because device locations rarely change, the alert location will normally be the same as the device
location. However, if the device location is changed, the following will occur:
•

New events show the new location, but are added to the existing (and open) alert at the old location.

•

When the alert is closed by an operator, any new events create a new alert at the new location (the
location reference in the alert is now consistent with the device location in the event).

For example:
1.

Events are added to Alert 1 at the original Location 1:
Alert 1

Location 1

Device 1

Event 99 Location1

device1

Event 98 Location1

device1

Etc.
2.

The device location is changed to Location 2.

3.

New events generated for an existing (and open) Alert 1 are added to the alert using the new Location
2, but the alert is still associated with the original Location 1.
Alert 1

Location 1

Device 1

Event 101 Location2

device1

Event 100 Location2

device1

Event 99 Location1

device1

Event 98 Location1

device1

Etc.
4.

An operator closes the alert (by right-clicking on it).

5.

New events are associated with a new alert in the new Location 2 (the location reference in the alert
is now consistent with the device location in the event).
Alert 2

Location 2

Device 1

Event 103 Location2

device1

Event 102 Location2

device1

Etc.
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Summary of Events and Corresponding Alerts
The following table summarizes the events that are included in each Cisco VSM 7.0 alert.

Note

Table 6-2

Some alerts include events of multiple types. For example, the motion alert can include the
“motion_start” and “motion_stop” events.

Events Included Under the Cisco VSM Alerts

Description of the alert per event
type

Alerts

Events included in the alert

Severity

analytics

analytics_occurred

INFO

Analytics event of type {0} occurred
for rule {1}

auto_discovery

auto_discovery

N/A

N/A

capability_mismatch_status

capability_mismatch_status

CRITICAL

Configuration defined in the
template and the configuration
supported by the camera do not
match

INFO

Issue with respect to configuration
defined in the template and the
configuration supported by the
camera has been cleared

CRITICAL

Chassis Intrusion is critical

INFO

Chassis Intrusion is normal

chassis_intrusion
clipping

chassis_intrusion
clip_start

Clipping initiated - {0}
INFO

clip_completed

INFO

clip_deleted

INFO

Clipping completed - {0}

Clipping deleted - {0}
config_mismatch_status

contact_closure

clip_failed

INFO

Clipping failed - {0}

config_mismatch_status

CRITICAL

Configuration in VSOM is not the
same as in Media Server for device
{0}

INFO

Configuration in VSOM same as in
Media Server for device {0}

contact_closure_opened

Contact closure opened on port {0}
INFO

contact_closure_closed

INFO

Contact closure closed on port {0}
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Table 6-2

Events Included Under the Cisco VSM Alerts (continued)

contact_closure_unconfigured_sta contact_closure_unconfigured_sta CRITICAL
tus
tus

coredump

coredump

device_status

device_status

Camera contact closure is not
configured but template defines
advanced events with contact-closure

INFO

Clearing contact closure
configuration issue with camera and
template

CRITICAL

{0} core dump critical
{0} Streaming status is critical

CRITICAL

device_config_status
device_stream_status

INFO

{0} Streaming status is normal

CRITICAL

Error in {0} device configuration

INFO

{0} device configuration is normal

device_stream_status

{0} Streaming videoloss
CRITICAL

device_connection_status

driverpack_mismatch_status

driverpack_mismatch_status

INFO

{0} Streaming status is normal

CRITICAL

{0} Streaming connection loss
occurred

INFO

{0} Streaming status is normal

CRITICAL

Driver-packs in Media Server does
not match with Driver-packs in
VSOM

INFO

Media Server's driver-pack matches
Operations Manager's

encoder_max_streams_used_statu encoder_max_streams_used_statu CRITICAL
s
s

event_overload_status

fan_speed

fan_speed

firmware_mismatch_status

fs_usage

event_overload_status

firmware_mismatch_status

fs_usage

maximum number of streams
reached for encoder

INFO

max_streams_reached issue is
resolved

CRITICAL

VSOM dropped {0} events due to a
large number of events received

INFO

Normal VSOM events processing
has resumed

CRITICAL

{0} is critical

INFO

{0} is normal

CRITICAL

Camera's template firmware does not
match the camera's firmware

INFO

Camera's template firmware matches
the camera's firmware

CRITICAL

File system usage on {0} is critical

INFO

File system usage on {0} is normal
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Table 6-2

Events Included Under the Cisco VSM Alerts (continued)

ha_config_mismatch_status

identity_collision_status

insufficient_backup_space_status

load_average
mem_free
motion

motion_unconfigured_status

nic_usage
password_expired_status

power_supply
raid_status

rcd_status

ha_config_mismatch_status

CRITICAL

Configuration in VSOM and primary
MS is not the same as in
redundant/failover Media Servers
{0}

INFO

Configuration in VSOM and primary
MS is same as in redundant/failover
Media Servers {0}

CRITICAL

Another device with one or more
identity criteria exists in the system.

INFO

Identity collision is resolved.

CRITICAL

Insufficient space is stopping
automatic VSOM database backup

INFO

Automatic VSOM database backup
is normal

CRITICAL

Load average is critical

INFO

Load average is normal

CRITICAL

Memory usage is critical

INFO

Memory usage is normal

motion_start

INFO

Motion started on {0}

motion_stop

INFO

Motion stopped on {0}

motion_unconfigured_status

CRITICAL

Motion window is not configured on
the camera. Record on motion and
other actions will not work.

INFO

Motion window is configured on the
camera.

CRITICAL

{0}'s Nic usage is critical

INFO

{0}'s Nic usage is normal

CRITICAL

Password expired - needs a password
change

INFO

password changed

CRITICAL

{0} Power supply is critical

INFO

{0} Power supply is normal

CRITICAL

Virtual drive{0} Raid failure is
critical

INFO

Virtual drive{0} Raid failure is fixed

CRITICAL

{0} Recording status is critical

INFO

{0} Recording status is normal

INFO

Parts of the recording {0} was
groomed to free up disk space

identity_collision_status

insufficient_backup_space_status

load_average
mem_free

nic_usage
password_expired_status

power_supply
raid_status

rcd_status

recording_groomed
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Table 6-2

Events Included Under the Cisco VSM Alerts (continued)

reachability

reachability

recorder_oversubscribed

redundancy_unconfigured_status

server_status

recorder_Oversubscription

redundancy_unconfigured_status

server_status

CRITICAL

{0} device is unreachable

INFO

{0} device is reachable

CRITICAL

{0} Disk space usage for recordings
has been over-subscribed

INFO

{0} Disk space usage for recordings
is normal

CRITICAL

Failover/Redundancy servers are not
configured for the camera's primary
media-server.

INFO

Failover/Redundancy servers are
configured for the camera's primary
media-server.

CRITICAL

Server status is {0}

INFO

Server status is START

soft-trigger

soft_trigger

INFO

Soft trigger {0} occurred on camera

temperature

temperature

CRITICAL

{0} is critical

INFO

{0} is normal

WARN

Media Server time does not match
with the VSOM time.

INFO

Media Server time matches with the
VSOM time.

CRITICAL

{0} Change in Media Server
configuration

INFO

{0} No Change in Media Server
configuration

ums_failover

WARN

UMS failed over {0}

ums_failback

INFO

UMS failed back {0}

ums_identity_mismatch_status

CRITICAL

UMS alternate id in Media Server
does not match with alternate id in
VSOM

INFO

UMS alternate id in Media Server
matches the alternate id in VSOM

CRITICAL

Media Server's version does not
match Operations Manager

INFO

Media Server's version matches
Operations Manager

CRITICAL

{0} Unknown hardware sensor is
critical

INFO

{0} Unknown hardware sensor is
normal

time_out_of_sync_status

ums_config_change

ums_failover_status

ums_identity_mismatch_status

ums_version_mismatch_status

unknown_hw_sensor

time_out_of_sync_status

ums_config_change

ums_version_mismatch_status

unknown
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Table 6-2

voltage

Events Included Under the Cisco VSM Alerts (continued)

voltage

CRITICAL

{0} is critical

INFO

{0} is normal
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Viewing Cameras and Alerts on Map
The Map Centric Workspace
(Figure 7-1) displays maps of the region, city, building or other areas
where the Cisco VSM is deployed. Click a location to view the associated map, and a list of available
cameras for that location. To view video, double-click a camera icon
to open a pop-up window.
Figure 7-1

Map Centric Workspace

1

Map Centric Workspace tab

2

Location hierarchy

3

Selected location
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4

Show/Hide the sidebar

5

Map for the selected location.

6

Alerts for the selected location.

Viewing Cameras and Alerts on Map

Click the Time or Severity column headers to sort the displayed alerts.
•

Only headings with an arrow are sortable.

•

The Time column sorts alerts with the newest alert at the top.

•

The Severity column sorts alerts with the most severe alert at the top (in the order of CRITICAL, MAJOR, MINOR,
WARNING, INFO).

See the “Common Tasks” section on page 6-7 for more information.
7

Right-click an alert to change the status or enter a comment.
See the “Common Tasks” section on page 6-7 for more information.

8

9

Click the lock icon to stop or start auto-updates.
•

When unlocked

•

When locked
, dynamic updating is paused and only the currently displayed alerts are shown. Unlock the display
to refresh the results.

Camera icon

, new alerts will be added to the list as they occur.

.

•

Double-click the icon

to view live or recorded video from the camera in a pop-up window.

•

Double-click anywhere on the map to zoom the map image.

•

Right click a camera icon (or camera name) to display the camera details (name, description, timestamp and
stream).

10 Pop-up video viewing window. Double-click a camera icon

to open the window.

Procedure

To view video from cameras at a specific location, do the following:
Step 1

Select the Map Centric Workspace

(Figure 7-1).

Step 2

Expand the location hierarchy and select a location from the list.

Step 3

(Optional) Right-click an alert to change the status or enter a comment.

Step 4

(Optional) Double-click a camera icon

Step 5

Review Figure 7-1 for additional options.

to view video for that camera in a pop-up window.
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Editing Locations and Maps
Refer to the following topics to edit the locations and associated map images displayed in the Cisco
Video Surveillance Safety and Security Desktop (Cisco SASD) application.
Contents
•

Map Editor Overview, page 8-2

•

Editing Locations, page 8-3

•

Adding or Updating Map Images, page 8-5

•

Placing a Sub-Location on a Map, page 8-6
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Map Editor Overview

Map Editor Overview
Use the Map Editor to add and edit locations, assign map images to the locations, and drag and drop
cameras onto the maps. These locations, maps and cameras are displayed in the Map and Alert Centric
Workspaces and help to visually identify the available video sources (see the “Viewing Alerts” section
on page 6-1 and the “Viewing Cameras and Alerts on Map” section on page 7-1).
To edit the location names and maps, select File > Map Editor. Figure 8-1 describes the main map editor
features.
Figure 8-1

Map Editor

1

Locations—Right-click to add or edit locations. See the “Editing Locations” section on page 8-3.

2

Cameras—The cameras assigned to the selected location. Drag camera icons onto the map to represent the location of
the video source.
Tip

3

Use the browser-based Cisco VSM Operations Manager to add or edit the available cameras.

Map Image—The map for the selected location. Enter a map name and description, click Browse to select an image,
and then click Add or Update to change the image.
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4

Camera icon—Represents a video source in the map image. Click the lock icon
to lock the image (
camera name onto the map image. Click the arrow next to the camera name to rotate the icon.

5

Sub-Location—A clickable area on the map that represents a sub-location. Click the lock icon
to lock the image
( ) and drag the sub-location onto the map. Use the tools in the corners and center of the blue box to resize or move
the clickable area.

6

Lock icon—Click the lock icon
to lock the image ( ) and prevent it from changing when you drag cameras and
sub-locations onto the map (sub-locations are clickable areas that appear in the Map Centric Workspace).

7

Reset—Click to fit the map to the viewing area. This may be necessary after resizing the window.

) and drag a

Add—Adds a new map is no map exists for the selected location (click Browse and select an image file from a local or
network drive).
Update—Saves changes to the image is a different map is selected or if sub-locations or cameras are added.
Remove—Removes the location image, sub-locations and camera icons.
8

Browse—Identifies the map image file that will be used to Add or Update the image displayed for the location.
The supported file formats are: jpg, jpeg, png, bmp, gif, tiff, and tif.

9

Map name and description.

Editing Locations
Locations allow you to organize your deployment according to the real-world location of equipment and
users. Locations also allow administrators to restrict user access to the specific cameras, policies, and
data (such as alerts) required by the user’s role within the organization. For example, while a
super-admin has full access to all locations and devices, a local campus administrator might have access
only to the devices and policies required to manage that site.
For example, a create a top-level location for a city or region. Then create sub-locations for the cities
where Cisco VSM cameras are installed. You can create additional sub-locations for a geographic
location, campus, building or other area, such as floors, lobbies, or doors.

Note

•

The Locations displayed in the Cisco Safety and Security desktop application are the same as those
displayed in the web-based Cisco VSOM administration tool. Changes to the Location hierarchy in
either application are reflected in both tools. For example, if you add or rename a location using the
desktop application, those changes also appear in the web-based administration tool.

•

Locations are also edited using the browser-based Cisco VSM Operations Manager. Since Locations
are also assigned to cameras, Media Servers, users, and other system attributes, only administrators
should add or edit the locations to ensure system integrity.

Procedure

To add or edit a location, right-click a location name and select an option from the menu.
Step 1

Select File > Map Editor.
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Editing Locations

Figure 8-2

Step 2

Tip

Editing Locations

Select an option from the menu.
•

Add Location—Adds a location at the same level as the selected location.

•

Add Sub-Location—Adds a Location as a child of the selected location.

•

Rename—Changes the location name

•

Delete—Removes the location. Locations can only be removed if no devices or other attributes are
assigned to that location. Use the Cisco VSM Operations Manager to re-assign system attributes to
another location, if necessary.

Drag-and-drop locations to change their position within the location hierarchy.

Step 3

(Optional) Add a map image to the location as described in the Adding or Updating Map Images, page 5.

Step 4

(Optional) Drag and drop cameras on to the map image. Click the arrow next to the camera name to rotate
the icon.

Cisco Video Surveillance Manager Safety and Security Desktop User Guide

8-4

OL-27379-06

Chapter 8

Editing Locations and Maps
Adding or Updating Map Images

Adding or Updating Map Images
Map images are assigned to a location, and appear in the Map and Alert Centric Workspaces.

Note

The supported file formats are: jpg, jpeg, png, bmp, gif, tiff, and tif.
To add or update the map image for a location, select a location, and then select the map image file that
should appear for that location, as shown in Figure 8-1 on page 8-2. You can also enter a name and
location for the map image.
Procedure

Step 1

Select File > Map Editor.

Step 2

Select a location.

Step 3

In the Map Details section, define the map image:

Step 4

Step 5

Tip

Step 6

a.

Enter a name and description for the map image.

b.

Click Browse to select a map image file form a local or network drive.

(Optional) Drag and drop cameras on to the map image. Click the arrow next to the camera name to rotate
the icon.
•

Click a location to display the cameras associated with that location.

•

Click the arrow next to the camera name to rotate the icon.

Click Add or Update.

Click Remove to remove the map image. The map image is removed from the Cisco Safety and Security
application, but the image file is not deleted from your hard drive.
Continue to the “Placing a Sub-Location on a Map” section on page 8-6.

Related Documentation
•

Placing a Sub-Location on a Map, page 8-6

•

Viewing Alerts, page 6-1

•

Viewing Cameras and Alerts on Map, page 7-1
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Placing a Sub-Location on a Map
Sub-locations can be added on a map to indicate where Cisco VSM equipment is installed or managed
(Figure 8-3). The sub-location is clickable and jumps the user to the sub-location map.
Figure 8-3

Adding a Sub-Location to a Map
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Sub-locations allow users to view various levels of detail, depending on the location of the camera, alert,
or other attribute. Figure 8-4 shows a regional map, the campus map for a sub-location, and the building
map for further sub-location.
Figure 8-4

Sub-Locations: Region, Campus and Building

Procedure
Step 1

Select File > Map Editor (Figure 8-1).

Step 2

Select the parent location where the sub-location will be added.
For example: California.

Step 3

Click the lock icon
Tip

Step 4

When the icon is locked (

), you can select a sub-location without changing the current view.

Drag and drop the sub-location to the map:
•

Step 5

to lock the image.

For example, drag the Milpitas sub-location onto the California map.

Resize the sub- location (Figure 8-1).
Figure 8-5

Sub-Locations: Region, Campus and Building

•

Use the corner icons to resize

and rotate

•

Drag the edge to change the shape.

•

Click the center icon

the box.

to drag the box to a different position.
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Step 6

Step 7

(Optional) Drag and drop cameras on to the map image. Click the arrow next to the camera name to rotate
the icon.
•

Click a location to display the cameras associated with that location.

•

Click the arrow next to the camera name to rotate the icon.

(Optional) Add a map image to the sub-location. The map image will appear when users click the shaded
map area in the Map Centric Workspace. If no map image is added, then a detail view of the parent map
is displayed.
a.

Click the lock icon

to unlock it.

b.

Select the sub-location.

c.

Add the map image, name and description, as described in the “Adding or Updating Map Images”
section on page 8-5.

d.

(Optional) Drag and drop cameras on to the map image. Click the arrow next to the camera name to
rotate the icon.
– Click a location to display the cameras associated with that location.
– Click the arrow next to the camera name to rotate the icon.

e.

Click Add or Update.
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Related Documentation
Use one of the following methods to access the Cisco Video Surveillance (Cisco VSM) documentation:
•

Click Help at the top of the screen to open the online help system.

•

Go to the Cisco Video Surveillance documentation web site.

•

See the Cisco Video Surveillance 7 Documentation Roadmap for descriptions and links to Cisco
Video Surveillance documentation, server and storage platform documentation, and other related
documentation.
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Revision History
Revised: September 13, 2013

Table B-1

Revision History

Release

Document Revision Date

Change Summary

Release 7.0.0

January, 2013

Initial draft.

Release 7.0.1

March, 2013

•

Added overview information and user-interface (UI) enhancements to
“Viewing Alerts”, including the following new and revised topics:
– “Understanding Events and Alerts”
– “Alert Centric Workspace Overview”
– “Viewing Event URLs”
– “Summary of Events and Corresponding Alerts”

•

Added user-interface (UI) enhancements to “Viewing Cameras and Alerts
on Map”.

•

Added a “Configuring Unattended Windows” section, including:
– “Launching the Unattended Windows”
– “Understanding Offline Mode”

Release 7.2

August, 2013

•

Various minor edits and revisions.

•

Revised the “Related Documentation”section.

Added the “Viewing a Thumbnail Summary of Video Archives” section on
page 5-1.
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